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Creator Quick Start Guide 
 

A guide for using the Creator software to design the SmartView products 

 

Warranty 

All products manufactured by ICP DAS are warranted against defective materials for a period of one year 

from the date of delivery to the original purchaser. 

Warning 

ICP DAS assumes no liability for damages consequent to the use of this product. ICP DAS reserves the right 

to change this manual at any time without notice. The information furnished by ICP DAS is believed to be 

accurate and reliable. However, no responsibility is assumed by ICP DAS for its use, nor for any 

infringements of patents or other rights of third parties resulting from its use. 

Copyright  

Copyright ©  2014 by ICP DAS. All rights are reserved. 

Trademarks  

Names are used for identification purposes only and may be registered trademarks of their respective 

companies. 

License 

This license allows the software to be used, modified and backed up on a single machine. This software, or 

any copy thereof, in whole or in part, may not be reproduced, transferred or distributed, in any form or by 

any means, including electronic, mechanical, photocopying, recording or otherwise, without the prior 

written permission of ICP DAS. 

Technical Service 

If you encounter any difficulties or have any questions, feel free to contact your local agent or contact 

ICPDAS by email at: service@icpdas.com or service.icpdas@gmail.com. We will respond within 2 working 

days. 

 

For more product information, refer to the ICPDAS website at: www.icpdas.com 

 

Latest editor Janice Hong, R&D Dept., ICP DAS CO., LTD.  

V.1.0.3 : Feb. 2017 
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Chapter 1 Introduction to Creator 

Creator is a professional development toolkit especially designed for the SmartView (or HA-401) series of 

devices produced by ICP DAS. Creator can be used to integrate several commonly used PLC communication 

protocols, providing rich and flexible object editing tools that allow easy navigation and adjustment of 

window management, repeated import and export of data in order to shorten the development process, 

simple uploading or updating of SmartView (or HA-401) projects using the built-in TCP transport, and the 

construction of control systems, ranging from a small and simple local control/monitoring application to 

management systems for large buildings, factories, and engine rooms, etc. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Features 

 Supports commonly used PLC Communication Protocols  

 Easy to create HMI Projects without the need for complex coding  

 Diverse range of HMI Objects and Functions, including: 

- Alarms, Schedules, Recipes, Data Logging, Macros, etc.  

 Update Projects via Ethernet  

 Supports MQTT  

 Online/Offline Simulation 

 Supports Multiple languages (Traditional Chinese/Simplified Chinese/English) 
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Chapter 2 Software Installation 

The following provides details related to the installation of the Creator software, including the 

recommended operating system and hardware specifications. 

2.1 Hardware and Software Specifications 

Before installing the Creator software, ensure that both the hardware specifications and operating system 

are sufficient to allow the efficient performance of the software. 

 

2.1.1 Recommended Operating Systems 

 Microsoft Windows 7 or later 

 Microsoft .Net Framework version 3.5 or later 

 

2.1.2 Recommended Hardware Specifications 

 CPU: 1.8 GHz or better 

 Memory: Minimum of 1Gb RAM 

 Hard Disk: At least 40G of free space 

 Display: Full-color display that supports a resolution of 800*600 or better 

 

 

2.2 Installation Procedure 

2.2.1 Installing from the Companion CD 

 Automatic:  

After inserting the companion CD into the CD-ROM, Windows will automatically launch the 

installation file. Note that if the “Autorun” feature is not enabled in Windows, this function will not 

work and the manual method described below must be used. 

 

 Manual:  

Double-click the Creator_Setup.exe file that can be found in the root directory of the CD-ROM to 

launch the installation file. 
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2.2.2 Setup Wizard 

Install the software Creator by following the instructions given in the Setup Wizard. 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 

 
 

 

 

 

 

 
 
 
 
 
 

 
 
 
 
 
 
 

 

 

 
 
 
 
 

 

1. Click the Next button to begin the installation 

process. 

1 

2. On the Select Destination Location screen, 

either click the Next button to install Creator 

into the default folder, or click the Browse… 

button to select an alternate folder, and then 

click the Next button to continue. 

2 

3. On the Select Start Menu Folder screen, either 

allow the shortcuts to be created in the default 

Start Menu folder, or click the Browse… button 

to select an alternate folder, and then click the 

Next button to continue. 

3 

4. On the Select Additional Tasks screen, check 

the Create a desktop icon checkbox to create a 

shortcut on the desktop, and then click the 

Next button to continue. 

4 
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2.2.3 Execute the Creator software 
 

To launch Creator, double-click the shortcut that was created on the desktop. 

 

 

Alternatively click the Start button, 

and then point to All programs. 

Point to the Creator folder and 

then click Creator. 

 

 

6. The Setup Wizard will display a progress bar to 

indicate the status of the installation process.  

Click the Cancel button to stop the installation 

if necessary. 

6
6 

5 5. On the Ready to Install screen, verify that the 

settings are correct, and then click the Install 

button to begin the installation. 

7 7. Once the installation has been completed, click 

the Finish button to exit the Setup Wizard. 

Note:  

To automatically launch Creator once installation is 

complete, check the Launch Creator checkbox. 
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Chapter 3 Overview of the Software Interface 

3.1 Program Window Interface 

The diagram below provides an overview of the Creator interface, including the various menus and view 

areas, each of which is described in more detail below. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu Toolbar The Menu Toolbar contains the six main functions of the Creator application. 

The tree structure can be expanded by clicking the menu. 

Tools Toolbar The Tools Toolbar contains icons for the most commonly used functions. Icons 

for other functions are also contained in the toolbars for the Design, Language, 

Status, Object, View and Toolbox functions. Hovering the mouse over the icon 

will display instructions for using the function. 

Screen Design Area The Screen Design Area is the main working area in the Creator application, 

and is used for designing, editing, and viewing the HMI screen and functions 

  

Screen Design Area 

 

Creator 
Language 
Toolbar 

Menu 
Toolbar 

Move Handle Screen Status 
Toolbar 

Design 
Toolbar 

Standard 
Toolbar 

Status 
Toolbar 

Device 
Language 
Toolbar 

Tool Box 

Project View 

Object View 

Screen View 

Library Output View Search 
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Chapter 4 First Project: Hello World 

“Hello World” is the most basic program that is used by every computer programming language to output 

the string “Hello World”, and is also traditionally used by beginners to practice when learning a new 

language. 

Using Creator, the “Hello World” program can be easily generated without the need for any programming 

knowledge. Use the procedure described below to build a SmartView project in Creator and output the 

message “Hello World” on the SmartView HMI screen. 

4.1 Creating a New Project 

Follow the instructions described below to create a new project in the Creator software. 

4.1.1 Create a New Project 

A new project can be created using a variety of methods, each of which is described below. 

A. From the menu Project menu, click the New item to begin creating a new project, or 

B. Click the New button in the Standard toolbar, or 

C Click the New project item in the Startup screen. 

   or      or 
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4.1.2 Select the SmartView Model 

As described above, a dialog box will be displayed allowing the SmartView Series HMI Model to be 

selected. Choose an appropriate option from the HMI drop-down menu and then click the OK button. 

The New Project Wizard will then be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

4.1.3 Enter the Project Information 

In the New Project Wizard, enter a name for the project in the Project Name field, and then enter an 

appropriate description and version number, if necessary, in the respective fields. Click the Next button 

to continue. 
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4.1.4 Create the Connection 

In this case, there is no need to set up a connection for the “Hello World” project, click the “Next” 

button to skip this step. If necessary, the connection can be configured later. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

4.1.5 Import the System Variables 

In this case, there is no need to import any system variables, so click the “No” option button and then 

click the “Complete” button to finish creating the project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

If you choose Yes, double click the Variable item in 

the Project View panel to view system variables. 
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4.2 Using Objects 

To display the “Hello World” text on the SmartView screen, use a “Label” object that can be found in the 

“Drafting” panel of the “Toolbox”. 

4.2.1 Adding an Object 

Step 1: Click the “Label” component in the “Drafting” panel of the “Toolbox”. 

Step 2: Click on the screen design area of the SmartView HMI to place the label component. 

 

 

 

 

 

 

 

 

 

 
 

4.2.2 Configuring the Properties for the Object 

Specific properties can be set for each individual object. To change the text of the “Label” object, 

double-click the object to open the “Property View” dialog box. Click the “General” property for the 

“Label” object, and then type “Hello World” in the text field.  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

2. Click on the screen design area, or drag out a 

proper size of shape. 

1. Click the Label object 

Click the Label object 

Type “Hello World” in the text field, and the font 

and colors can also be changed as desired. 
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4.3 Uploading the Project 

Before the project can be uploaded to the SmartView device, the target IP Address must first be 

configured. 

 

 

4.3.1 Configuring the Connection for the HMI Project 

In the “Project View” panel, click the “Settings” item and then click 

the “Upload” tab in the “Settings” dialog box. Configure the settings 

for the target and the connection mode from the respective 

drop-down menus, and then enter the IP address in the “IP” text 

field. 

 

  

Double click this item 
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4.3.2 Compilation and Upload 

To download the project, click the “Upload” item from the “Tools” menu. The project will be compiled 

first, and then, if compiled successfully, it will be downloaded to the target device based on the 

download settings. 

 

 

 

 

 

 

 

 

 

 

 

 

The result of the compilation process will be displayed in the “Output View” window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once the compilation process is complete, the project will be uploaded. 
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4.4 The Result on the SmartView Device 

If the project has been successfully compiled and uploaded, the result should be displayed on the 

SmartView device as illustrated below. 
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Chapter 5 Example: Modbus Device Monitor/Control 

The following example uses a SmartView SV-2201 and an M-7045D Modbus device with 16 DO channels. 

This example provides an illustration of how to use more advanced Creator operations, such as listing 

connections, setting variables, as well as component selection and usage, allowing a project to be built 

more easily and rapidly. 

 

 

 

5.1 Creating a New Project 

5.1.1 New a Project 

Click “New” from the “Project” menu to create a new project. 
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5.1.2 Select the SmartView Model 

Select the SmartView Series HMI Model from the “HMI” drop-down menu, and then click the “OK” 

button to continue. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.1.3 Enter the Project Information 

Enter a name for the project in the “Project Name” field, then enter a description for the project and the 

version number in the respective fields, and then click the “Next“ button to continue. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

[18] 

Copyright ©  2014 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com 

Creator Quick Start Guide Ver.1.0.3 

5.1.4 Create the Connection 

A.  Select COM Port and Protocol 

Select the COM port and the communication protocol to be used to connect to the Modbus M-7045D 

module. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

B.  Port Configuration 

To configure the port, click the “Port Configuration” button to open the “Port Setup” dialog box. 

 

  

In this example, COM2 on the 

SV-2201 is used to connect the 

M-7045D as a Modbus Slave. 

Select the required values for the device to 

be connected, e.g., the M-7045D in this case, 

from the respective drop-down menus, then 

click the “OK” button to continue. 
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C.  Create a New Connection 

1. Click the “New” button to add a connection. 

2. In the “Connection Editor” dialog box, enter a name for the new connection and configure the 

communication parameters, including the COM Port and the Station number (Net ID), and then click 

the “OK” button to continue. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. The new connection will be listed in the “Connections” dialog box. Click the “Next” button to 

continue. 

 

  

Net ID 

3 

1 

2 
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5.1.5 Import the System Variables 

In this case, there is no need to import any system variables, so click the “No” option button and then 

click the “Complete” button to finish creating the project. 
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5.2 Configuring Variables 

5.2.1 Modbus Address for the M-7045D Module 

Enter the Modbus address for the M-7045D module, which can be found in the User Manual for the 

module, as illustrated below. 

M-7045/M-7045D:  

Valid Starting Channel 0x0000 ~ 0x000F for DO Output 

 

5.2.2 Add Variables 

A.  Project View - Variable 

To add a new variable to the project, double-click the “Variables” item in the “Project View” panel, then 

click the “New” button to open the “Add a New Variable” dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the “Add a New Variable” dialog box, enter a name for the new Tag, then select the name of the 

connection that was created in the previous step, “Connect_1” in this case. From the “Type” drop-down 

menu, select “BOOL”, and then click the options button for the “Address” field to open the “Addressing” 

dialog box. 

  

0x : Coil Status 

Address 1 is the first tag of the M-7045D 

Select the name of the connection that was 

created in the previous step, “Connect_1” in 

this case. Then, select “BOOL” from the “Type” 

drop-down menu for the M-7045D DO. 
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In the “Addressing “ dialog box, select the required value from the “Register” drop-down menu, and 

then enter the required Address in the text box. Click the [] button to save the settings. 

 

Click the “OK” button to save the new Tag. 

 

B.  Quickly Adding New Variables 

Once the first variable has been created, an alternative method exists for creating additional variables. 

Double-click the next blank row in the “Variable List”, and Creator will automatically create the next 

variable. Once created, click the “Edit” button to change the settings where necessary. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once the first variable has been created, double-click 

the next blank row in the “Variable List”, and Creator 

will automatically create the next variable. 
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5.3 Using Objects 

In order to control and display the ON/OFF states of the M-7045D DO points on the SmartView, use the 

“Bit Switch” object in the “Switch” Toolbox and set its action type as “Toogle”. 

5.3.1 Adding an Object 

Step 1: Click the “Bit Switch” object in the “Switch” panel of the Toolbox 

Step 2: Click on the screen design area of the SmartView HMI to place the Switch 

 

 

 

 

 

 

 

 

 

 

 
 

5.3.2 Configuring the Properties for the Object 

Click the object to open the Property View dialog box. Click the “General” property, and then select the 

required Read and Write variables and set the type as “Toggle”, as illustrated below.  

Repeat the process described above to add 15 more Toggles for the 16 DO points. 
 

 

 

1. Click the object 

2. Click on the screen design area, or drag out a shape. 

Click the object 

Select the write/read variables 

and set the Type as “Toggle”. 
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5.3.3 Viewing Information about Object Properties 

After configuring all 16 Bit switches, simply moving the mouse over the object, the property information 

of the object will be displayed.  

 

 

 

 

 

 

 

 

 

 

 

5.4 Uploading the Project 

Before the project can be uploaded to the SmartView device, the target IP 

Address must first be configured. 

 

5.4.1 Configuring the Connection for the HMI Project 

In the “Project View” panel, click the “Settings” item and then click the 

“Upload” tab in the “Settings” dialog box. Configure the settings for the 

target and the connection mode from the respective drop-down menus, 

and then enter the IP address in the “IP” text field. 

 

  

Double click this item. 
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5.4.2 Compilation and Upload 

To upload the project, click the “Upload” item from the “Tools” menu. The project will be compiled first, 

and then, if compiled successfully, it will be uploaded to the target device based on the upload settings. 

 

 

 

 

 

 

 

 

 

 

 

 

The result of the compilation process will be displayed in the “Output View” window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once the compilation process is complete, the project will be uploaded. 

 

 

 

 

  

Successfully Compiled. 
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5.5 The Result on the SmartView Device 

If the project has been successfully compiled and downloaded, the result should be displayed on the HMI 

device as illustrated below. 
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Appendix 1: SmartView Operations 

The following provides an overview of the operations that can be performed on the SmartView device, 

including how to execute a project either automatically or manually, together with details of the functions 

available in the Control Panel of the SmartView device. 

 

 

 

 

 

 

 

 

 

 

 

 

 

A. Executing a Project Automatically 

By default, the SmartView will automatically load and run the project once it boots up. 

  

Note:  To prevent the project from automatically loading, tap anywhere on the screen as it is loading, 

as illustrated below. 

 

 

  

Display the progress of loading the project 
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B. Executing a Project Manually 

In some cases, you need to execute a project manually. For example, either after uploading a project to 

the SmartView, or after configuring most of functions in the Control Panel, the SmartView will not 

automatically run the project. Thus, you can tap the Run Project icon to manually execute a project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

C. Control Panel 

The Control Panel is used to configure a variety of functions, each of which are described in more detail 

below, and include options such as changing the system date and time, configuring the IP settings and 

calibrating the sensitivity and accuracy of the touch screen, etc.  

 

To access the Control Panel, tap the Control Panel icon and the settings screen will be displayed.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Settings Screen 
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The following is an overview of the options available in the Control Panel. 

 

 

C.1  Date/Time Settings 

The Date/Time Settings function is used to adjust the system date and time for the SV-x201 

device. 

To adjust the Date and Time Settings for the SV-x201 device, tap the Date/Time Settings icon in the Control 

Panel to open the Date/Time Settings screen. 

 

 

 

 

 

 

 

 

 

 

After tapping the value you want to adjust, the Numeric Keyboard will be displayed as below. Input the 

value for the year (or month / day / hour / minutes / seconds) field, and then tap the Enter button to 

complete the setting, as illustrated in the figure below. Finally, click the OK button to apply the settings. 

 

Used to adjust the system date and time settings 

 

Used to configure the IP address, etc. for the SV-x201 device 

 

Used to calibrate the sensitivity and accuracy of the touch screen  

 

Used to specify the NTP server and the time zone for the SV-x201 device 

 

Used to specify the language settings for the SV-x201 device 
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The following is an overview of the options available in the Date/Time Settings screen for the Date/Time 

Settings function in the Control Panel 

Date Used to adjust the system date 

Time Used to adjust the system time 

OK Used to apply the settings and exit the screen 

Cancel Used to exit the screen without saving the configuration settings 

 

 

C.2  IP Settings 

The IP Settings function is used to configure the IP address, Network Mask, Gateway address 

and DNS Server address for the SV-x201 device. 

 

To configure the IP address, tap the IP Settings icon in the Control Panel to open the IP Settings screen.  

Enter the relevant details in the respective fields and then tap the OK button to apply the settings. 
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The following is an overview of the options available in the IP Settings screen for the IP Settings function in 

the Control Panel. 

IP Address Used to specify the IP address for the SV-x201 device 

Network Mask Used to specify the Network Mask for the SV-x201 device 

Gateway Used to specify the Gateway address for the SV-x201 device 

DNS Server Used to specify the address of the DNS Server for SV-x201 device 

Obtain an IP address 

via DCHP 

Used to specify whether or not the IP address for the project should be 

obtained via a DCHP server 

OK Used to apply the configuration settings and exit the screen 

Cancel Used to exit the screen without saving the configuration settings 

 

 

 

C.3  Screen Calibration 

The Screen Calibration function is used to calibrate the sensitivity of the touch screen and can 

be used to adjust the accuracy of the response to user input. 

 

To calibrate the sensitivity and accuracy of the touch 

screen, tap the Calibrate icon in the Control Panel to 

open the Screen Calibration screen.  

On the Calibration screen, tap and briefly hold the 

target (cross) in the center of the screen. Repeat this 

process as the target moves around the screen.  

After completing the process, it will automatically return to the Control Panel. 
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C.4  NTP Server 

The NTP (Network Time Protocol) Server can be used to automatically synchronize the system 

time of the SV-x201 device with a remote server. 

 

To configure the NTP server, tap the NTP 

icon in the Control panel to open the NTP 

screen. 

Choose one of the NTP server and the time 

zone, and check the Enable NTP checkbox 

and then tap the OK button to apply the 

settings. 

 

The following is an overview of the options available in the NTP screen for the NTP function in the Control 

Panel. 

NTP Server  Used to specify the NTP Server for updating the system time  

Time Zone Used to specify the Time Zone 

Enable NTP Used to enable the NTP function 

OK Used to apply the settings and exit the screen 

Cancel Used to exit the screen without saving the configuration settings 

 

 

C.5  Language Settings 

The Language function is used to configure the language used for the SV-x201 device and can 

be selected from English, Traditional Chinese, or Simplified Chinese. 

 

To adjust the interface language, tap the 

Language icon in the Control panel to 

open the Language screen. Choose the 

desired language in the drop-down list, 

tap the Select button to select it, and 

then tap the OK button to apply the 

settings. 
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D. Exit the Project 

To exit the project and return to the Home screen, follow the procedure described below: 

Tap and hold the top left-hand corner of the screen (A). 

Slide your finger to the bottom left-hand corner of the screen (B). 

1. Release your finger to exit the project. 
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